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Chapter

Technical Support

Contacting Support

Phone. Our goal isto provide one-on-one technical support. However, based on the complexity
and/or frequency of calls, you may reach our phone-mail system. Leave your name, company
name, and telephone number, and a support member will call you back.

Fax. Send your name, company name, and tel ephone and fax numbers along with the detail s of your
request and the name of the product with which you need assistance.

Internet. Enter your reguest on the Support Web site. You can also use the site to find
documentation, download patches, open a case, and participate in the customer forum. See
“Internet Support” below.

E-mail. Include your name, e-mail address, company name, the feature that you have a question
about, and your question or request.

Internet Support
Table 1-1
Internet addresses
Site Address
Support Web site http: //support.spss.com
Documentation team e-mail docfeedback@spss.com

Thefollowing information is on the SPSS Support Web site at http://support.spss.com. It requires
youtologin.

Troubleshooting. Search for aresolution, view frequently used resolutions, open a support case, and
view the status of your cases.

Documentation. Read SPSS Support policies, browse the newsletters for technical issues, or view
and download the latest documentation, including the Installation Guide, Administrator’s Guide,
Upgrade Guide, and Quick Start guides.

Upgrade Info. Order an upgrade and view upgrade information pertinent to each release.

Patches. Download patches for al supported products.


http://support.spssshowcase.com
http://support.spssshowcase.com/
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My Corporate Info and My Personal Info. VView your agreements, passwords, cases, and other status

information.

Contacting Us. Find the most current phone numbers, e-mail addresses, and fax numbers for North
American, European, and Japanese/Asia Pacific support. You can also open a case here.

Customer Forum. Network with other maintenance customers in this discussion group.

Other Links. Find information about products, training, Webinars, and upcoming events.

North American Support

For the most current contact information, go to the SPSS Support Web site at
http: //support.spss.com. It requires you tolog in.

Table 1-2

North American services and support information

Topic Phone Fax E-mail

North American support (507) 288-5922 :

(relational products) Option 2, then option 1 (507) 287-2809 | scsUpport@spss.com
North American support (507) 288-5922 (507) 287-2809 | scsupport@spss.com

(multidimensional products)

Option 2, then option 2

Product training

and consulting services

(312) 261-6544

(847) 779-6544

TrainingServices@spss.com

European Support

For the most current contact information, go to the SPSS Support Web site at
http://support.spss.com. It requires you to log in.

Table 1-3

European support information

Country L anguage Phone Fax E-mail

Austria German 49 89 48 9074 333 32 2474 03 63 leursupport@spss.com
Belgium Dutch 32247717 00 32 2474 03 63 leursupport@spss.com
Belgium French 3224771701 32247403 63 eursupport@spss.com
Belgium German 322477 17 02 32 2474 03 63 eursupport@spss.com
Denmark Eﬁgl'ls;and 45 361 58731 32 2474 03 63 leursupport@spss.com
France French 3315521 25 32 32 2474 03 63 leursupport@spss.com
Germany German 49 89 48 9074 333 32247403 63 leursupport@spss.com
Italy Ei‘;ﬁ;a”d 39 0280 663036 3224740363  lursupport@spss.com
L uxembourg French 322477 17 03 32247403 63 eursupport@spss.com
Switzerland French 41 227 100034 32 2474 03 63 eursupport@spss.com
Switzerland German 49 89 48 9074 333 32 2474 03 63 leursupport@spss.com
IThe Netherlands  |Dutch 31 205 82 94 96 32 2474 03 63 leursupport@spss.com
United Kingdom  [English 44 1483 719 202 32247403 63 leursupport@spss.com



http://support.spssshowcase.com
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http://support.spssshowcase.com
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Japan and Asia Pacific Support

Technical Support

For the most current contact information, go to the SPSS Support Web site at
http://support.spss.com. It requires you to log in.

Table 1-4

Japan and Asia Pacific support information

Region Phone Fax E-mail

Japan and Asia Pacific 1603 6411 7660 603 6411 7661 j pscsupport@spss.com



http://support.spssshowcase.com
http://support.spssshowcase.com
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Chapter

Release Overview

Welcome to the STRATEGY Analyzer 6.1 Guide. This guide supports the limited availability
version of Analyzer and will help Analyzer administrators understand Analyzer enhancements,
restrictions, and requirements. It will also help them install Analyzer and set up security.

STRATEGY Analyzer supports Hyperion Analyzer 6.1 features and functions with iSeries-
specific differences and exceptions noted in this guide. For a complete list of Hyperion
enhancements, see the Hyperion Analyzer documentation.

An Adobe Acrobat (.pdf) version of thisguideisavailable onthe STRATEGY Analyzer CD-ROM.
Viewing and printing the document requires Adobe Acrobat Reader. If necessary, you can
download it a no cost from www.adobe.com.

For the latest release notes, see the Analyzer Readme (anzreadme.htm).

Locating Documentation

All Analyzer documentation can be found on the Analyzer Information Map after you install. Itis
located on the Analyzer Launch Page (http://hostname:port/Analyzer6/index.html). For
instructions on connecting to the Launch Page, see “ Connecting to the Analyzer Launch Page” on
p. 21.

You can aso find STRATEGY Analyzer documentation (this guide and the Analyzer Readme)
on the Technical Support Web site at http://support.spss.com. After you log on, click
Documentation > STRATEGY Manuals.

Enhancements

Sophisticated Graphical User Interface

The most important feature of Analyzer isthat it provides an easy-to-useinterface for sophisticated
multidimensional and relational analysis. Its methods and metaphors make online analysis as easy
as surfing the Internet.
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Scalability

Analyzer has been restructured to run inside leading J2EE-compliant application servers. The
supported J2EE Application Server shares Analyzer business logic, manages network traffic,
maintains system security for large numbers of concurrent users, and providesload balancing, fault
tolerance, and fail over.

Personalization

Users can personalize their Analyzer client through innovative new user preferences. Options
include:

m  Modifying the look and feel of the client interface
m Creating personal database connections

m  Creating points of view (POV) that superimpose the dimensions that interest the user in other
reports

m Creating personal variables (personally defined selection lists)

Relational Integration

A new easy-to-use interface expedites the process of drawing relational datainto Analyzer, and
enables users to explore relational data with the same analysis tools used to analyze online
analytical processing (OLAP) data.

Integrated Functionality and Design Tools Application

The Anayzer Java Web Client has been enhanced to perform all the functionality previously
provided by the Analyzer Windows Client and Analyzer Design Tools.

Licensing

Analyzer licensing is handled through Warehouse Manager Server. When you install Warehouse
Manager Server, you receive 60-day demo access to Analyzer. To enable Analyzer beyond the
demo period, you must enter your new license password viathe i Series interface or Warehouse
Manager Client. If you have an Analyzer license password from a previous Analyzer release, your
current password will work, and no updating is required.

Administrators can use Warehouse Manager Client to perform other licensing tasks such as adding,
changing, transferring, and removing Analyzer passwords and showing active connections. For
more information, see the STRATEGY Installation Guide, Chapter 4.
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Integrated Security

In Analyzer Administration Tools, the System Settings dialog box provides new
security/authentication options. You can now use Analyzer security with OS/400 without having
to recreate your OS/400 user groups/profiles. You will create and maintain users and groups with
Warehouse Manager Client or an iSeries command line. For more information, see “ Security
Settings’ on p. 21.

Important: When implementing security, use the security information in this guide, which
describes Analyzer on theiSeries.

View Report Script

A View Report Script option has been added to the Analyzer Java Web Client on the Tools menu.
Thisoption will display the Essbase report script for the active data source. If the active data source
isarelational database, then the SQL statement will be displayed. The report script or SQL
statement can then be copied and pasted into other applications, such as Essbase Application
Manager or Query. This feature may be helpful to administrators or Technical Support personnel
for debugging purposes. For instructions, see the Anayzer Java Web Client online help.

Linking to Executables
With drill linking in Analyzer Java Web Client, not only can you navigate to other reports by
double-clicking cells with pre-placed links, but you can also navigate to executable applications.
The Analyzer JavaWeb Client’s Select a Report dialog box, accessed from the Drill Link Options

dialog box, has a Link to Executables button. For more information, see the Analyzer Java Web
Client online help’s Drill Linking topic.

Exporting to Excel

Users can export Analyzer reports to Microsoft Excel. You can find instructions in Analyzer Java
Web Client online help’s Export to Microsoft Excel topic.

Enhanced Printing

Reports can be printed with a summary page and exported to Adobe Acrobat Reader .pdf files.

New Chart Types

Bubble, Spline, Curved Area, and Box Plot chart types are now available.
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New Commands

The following iSeries commands are new in this version of Analyzer.

Table 2-1
New Commands

Command Function Additional I nformation

Starts one or all Essbase/400 servers, including - ) .
STRESSSVR Essbase Enterprise Services server (EES) Esshase/400 Administrator’ s Guide
ENDESSSVR Egdss one or all Essbase/400 servers, including Essbase/400 Administrator’s Guide
ANZINST Installs Analyzer Installation and Uninstallation chapter
UNINSTANZ | Uninstalls Analyzer Installation and Uninstallation chapter
STREESCMD | Administers Essbase Enterprise Services (EES)| Analyzer Administration chapter

Release Notes

STRATEGY Analyzer supports Hyperion Analyzer 6.1 features and functions with the following

i Series-specific exceptions. For a complete list of release notes, see the Hyperion Analyzer
documentation.

Essbase/400 Dependencies

Analyzer connects to the Essbase/400 OLAP Server via Essbase/400 Enterprise Services (EES).
EES acts like a gate between Essbase/400 and Analyzer, so to access to Esshase/400 servers and
user profiles with Analyzer, you must add them to EES. The Essbase/400 information you add to

EES depends on your security setting. For more information, see “Connecting Analyzer to
Essbase/400” on p. 27.

Preserve Active Connections With Proper Logout

To properly release Analyzer active connections and licenses in Warehouse Manager Client, when
you log out of Analyzer, use the Logout button on the Analyzer tool bar, or select Logout from the
File menu. Your Active Connections value may be incorrect if users close the Analyzer window
without using the Logout option. However, it will be corrected when the Analyzer session times out
(default is 30 minutes). You can use the Anayzer Analysis Server Console to end the session or
change the timeout value.

Log Out of Analyzer Before Stopping the Orion Application Server

Stopping the Orion Application Server while users are still logged in to Analyzer will cause Orion
to use up an equiva ent number of Analyzer licenses permanently. Before stopping the Orion
Application Server (ENDORI command), make sure all users are logged out of Analyzer. To
forcibly log out all users, log in to the Analyzer Analysis Server Console, and select each box
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labeled Kill for all the User Sessions listed. Click the Submit button. Thiswill log out each user
from their session and release the session license. As the Server Console refreshes, the User
Session list will empty until there are no User Sessions left. Then it is safe to stop the Orion
Application Server.

No Lockout Recovery

Thereisno lockout recovery. Administrators locked out of Analyzer must reinstall the product.
Do not lose or forget your Administrator password. If you are locked out of Analyzer and must
reinstall, all datawill be lost. There is no way to rebuild or recover your repository.

Supported Relational Database

The only relational database officially supported at thistimeis OS/400 DB2 using the "native"
JDBC DB2 driver.

Note: In Analyzer Administration Tools, when configuring arelational database connection and
specifying OS/400 DB2 asthe Driver Type, remember thelibrary nameyou chosein the Database
Connection String section. When you proceed to the Select Table dialog box, be sureto select that
same library name. Otherwise, you won't have access to the column names in the tables you
choose.

To configurearelational database connection, open Analyzer Administration Tools. Right-click on
the Databases folder, and select New Relational Connection. This opens the Configure JDBC
Driver dialog box.

Figure 2-1
Configuring a relational database connection

Configure JDBC Driver m

JDEC Diriver Properties

Use DriverTvpe| OSi400 DE2 - |

JOEBC Drivercom.ibm.dh2 jdbe.app DBE2Driver

Databhase Connection Stringjdhc:db?:*LOCAL;IibrarieS:LIBNAME

Usernatme
FPassword
Test Connectian... |
‘f Ok || Cancel
Supported OLAP Database

Analyzer supports the Essbase/400 6.5 OLAP server.
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Supported Application Servers

The Orion Application Server isthe only supported application server at thistime. Documentation
references to Tomcat and Websphere application servers do not apply to this version of Anayzer.

Orion Application Server Installation Key

An Orion Application Server installation key isincluded with your software package. The key is
required during Orioninstallation on theiSeries. If you do not have akey, contact Technical Support
to obtain one. For information about Orion Application Server requirements, see “Orion
Application Server” on p. 14.

Migration and Release Compatibility

This version of Analyzer does not support migration from STRATEGY 4.x or Hyperion 5.x
Analyzer. In addition, this version is not compatible with any previous version of STRATEGY
Analyzer, and any connection of older clientsto the 6.1 server or of 6.1 clientsto older serversis
unsupported.

Saving and Restoring in Analyzer
STRATEGY 4.x The SAV SRVRINF and RSTSRVRINF commands are not supported in thisversion
of Analyzer. Restoring Analyzer 4.x datainto Analyzer 6.1 is not supported.

STRATEGY Analyzer 6.1 or Hyperion 6.1. To back up reports saved in thisiSeries 6.1 version or in the
Hyperion 6.1 Windows NT versions, you can use the Import and Export features in Analyzer Java
Web Client. However, you must manually recreate your database connections and user definitions.
For import and export instructions, see the Java Web Client online help.

Note: You cannot export from Hyperion Analyzer 6.0 directly into theiSeriesversion of 6.1. Doing
sowill result in an error message. If you plan to migrate your Hyperion Analyzer datato theiSeries,

you should first upgrade to Hyperion Analyzer 6.1 (on NT), and then the use the Export/Import
features.

Password Character Limit

Analyzer supports mixed case i Series passwords, including these special characters. @ #$ _

You can only sign on to Analyzer with a password of 30 characters or less.

Analyzer HTML Web Client Not Available.

The Analyzer HTML Web Client is not available in this version of Analyzer.
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Running Analyzer with Enterprise Reporting

If you are running Enterprise Reporting, be aware that both Enterprise Reporting and Analyzer use
the Orion Application Server. Starting or stopping the server for one application will affect the
other.
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Installation and Uninstallation

This chapter covers Analyzer requirements, installation, and uninstallation.

Licensing

Analyzer licensing is still handled through Warehouse Manager Server. When you install
Warehouse Manager Server, you receive 60-day demo access to Analyzer. To enable Analyzer
beyond the demo period, you must enter your new license password via the i Series interface or
Warehouse Manager Client. If you have an Analyzer license password from a previous Analyzer

release, your current password will work, and no updating is required. For licensing information,
see your STRATEGY Installation Guide, Chapter 4.

Environment Requirements

Read thisinformation carefully. If you fail to meet the software requirementsin this chapter,
Analyzer may not function properly.

iSeries Requirements

STRATEGY

Before installing Analyzer, you must have STRATEGY 4.5 installed with patch 4 (4.50.040) or a

later 4.5 patch. To determine your version, you can use the DSPSCAUT command on an i Series
command line.

Supported 0S/400 Version

Analyzer requires OS/400 Version 5 Release 1 (V5R1)

Disk Space

Make sure you have enough free disk space to install the server.

13
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Table 3-1
Disk space required for server installation

Component Space Required

Analyzer Server 100 MB
Temporary Space | 50 MB (After installation, this space is freed when the installer signs off.)

500 MB (This temporary spaceis allocated by JDBC and is used for
Run-time Space improving performance. The memory will be released when you stop the
Orion Application Server.)

Orion Application Server

Analyzer requires the Orion Application Server. If you did not install Orion when you installed the
STRATEGY servers, see“To Install Orion Application Server Using the INSTORI Command” on
p. 15. Orion Application Server must be stopped whileyou areinstalling Analyzer. For instructions,
see “ Starting and Stopping Orion Application Server” on p. 17.

Note: Enterprise Reporting and Analyzer both use the Orion Application Server. Stopping Orion
will affect both applications.
Esshase Requirements

If you will use Analyzer with multidimensional databases, Analyzer requires Essbase/400 6.5,
whichincludesthe Essbase/400 OL AP Server and Essbase/400 Enterprise Services (EES). You will
need your EES IP address (default 127.0.0.1) and port number (default 5001) when you install
Analyzer. You will aso need to enter the EES domain, which has a default of Essbase.

If you will not use Analyzer with multidimensional databases, you can accept the default
information during instal lation.

Java Developer Kit

Analyzer requires JDK 1.3.1 with Java group PTF SF99069-11 or |ater.

Database Support

Analyzer requires Database group PTF SF99501-09 or later.
You must also have the ability to run the iSeries RUNSQLSTM command.

Client PC Software and Hardware Requirements

The following table lists minimum client software and hardware requirements for Analyzer.



15

Installation and Uninstallation

Table 3-2

PC requirements

Computer IBM or IBM-compatible personal computer

. Microsoft Windows 98; Microsoft Windows NT 4.0, Service Pack 6; Microsoft

Operating System Windows 2000, Service Pack 2; or Microsoft Windows XP

Web Browser Microsoft Internet Explorer 5.5 or later

Microprocessor* | 450 MHz minimum. 850 MHz recommended.

RAM 128 MB

Hard Disk Space | 30 MB temporary space

*Because Analyzer processing is done via applet on the PC, performance will increase relative to

processor speed.

Java Plug-in

To usethe Analyzer JavaWeb Client and Analyzer Administration Tools, users must have Sun Java
Plug-in 1.3.1 with the latest patch. If you do not have the plug-in installed, you will be prompted
toinstall it when you log in to Analyzer and click the Java Web Client link or the Analyzer
Administration Tools link.

Note: You must have Administrator authority to install the plug-in.

To Install Orion Application Server Using the INSTORI Command

» Loadthe STRATEGY iSeries CD into theiSeries CD drive.

» AtaniSeriescommand line, add your 4.5 Warehouse Manager Server library nameto your library
list. For example, at the iSeries prompt, type:

ADDLIBLE SCSERVER

where SCSERVER is the library in which the Warehouse Manager Server isinstalled.

» At aniSeriescommand line, type INSTORI, and press F4.

» Enter the following information:
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Figure 3-1
Installing the Orion Application Server using INSTOR!

[Unitsthed] - ALUMEA AS FA00 Displagy

Fie Edt View Cormection Tjsnsier DOpfons Todk Hep

Dlsle] |-l -|F sls) ~l=lid elel vl

[INSTORI]

Type choices, press Enter.
Install dewice. . . . . . . . . ErTa Character walue
Orion server port. . . . . . . . 48671 Character walue
JHS serwver port. . . . . . . . . 45577 Character walue
User profile. . . . . . . . . . Mame
Password. . . . . . . . . . . . Mame
Subsystem. . . . . . 0L L L. OBASE Mame

Libraryg, « v v v v v 0 0 e e . L5YS Maime
ER migration tims. . . . . . . . ¥IHHED Tims, ¥IHMED, ¥DEFER
ER migration date. . . . . . . . ¥CURRENT Oate, *CURRENT
Install Key. . . . . . . . . . . Character value

Bottom

F3=Exit Fd4=Prompt F8=Refresh Fl12=Cancel F13=How to use this display
Fad=Hore keys

Orion Server Port. The Orion Application Server requires a port number different from the
Warehouse Manager Server port number. Accept the default port number (48671 or the next
available number) or enter aport number in the range of 6000-65535. To see what port numbers are
already in use, run the WRKSRVTBLE command from an i Series command line.

Note: Remember this port number. You will useit in your Analyzer URL.

JMS Server Port. This port is required by the Orion Application Server. Accept the default (45577
or the next available number) or enter a port number in the range of 6000-65535.

User Profile and Password. Enter an existing user profilethat has*ALLOBJ or *SECADM privileges,
and a password to be stored for security.

Subsystem and Library. Your current subsystem, as determined by the QCTLSBSD system value, is
displayed and should not be changed.

Note: If the controlling subsystem is QBASE, then QBASE is the default. If the controlling
subsystem is QCTL, then QCMN is the default. To find the controlling subsystem, type
DSPSYSVAL SYSVAL(QCTLSBSD).

The subsystem description resides in the specified Library. QSY Sis the default.

Install Key. Enter the Orion iSeries installation key. If you do not have a key, contact Technical
Support to obtain one.
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Starting and Stopping Orion Application Server

To start and stop the Orion Application Server, follow the instructions below. Orion Application
Server affects both Analyzer and Enterprise Reporting.

To Start or Stop Orion Application Server on an iSeries
To start or stop Orion Application Server on an iSeries, follow the steps described below.

Start. The STRORI command starts the Java process that starts Orion Application Server. Follow
these steps:

» Verify you have compiled the Java Toolbox classes as described in the STRATEGY
Administrator’s Guide.

» Logonwith*JOBCTL authority. * ALLOBJ authority is also recommended. However, if you
don’'t have * ALLOBJ authority, grant the user who will be using STRORI * USE authority to the
following aobjects:

STRORI (command type object) in the server library.
STRTCP (command type object) in QSY S.
QUSER (*USRPRF type object) in QSY S.

» Add thelibrary containing the Warehouse Manager Server to your library list. For example, at the
iSeries prompt, type:
ADDLIBLE SCSERVER
where SCSERVER is the library in which the Warehouse Manager Server isinstalled.

» To start Orion Application Server, at the i Series prompt, type STRORI.

Stop. The ENDORI command stops the Java process that is running Orion Application Server.
Follow these steps:

» Logonwith*ALLOBJand *JOBCTL authority.

» Add thelibrary containing the Warehouse Manager Server to your library list. For example, at the
iSeries prompt, type:
ADDLIBLE SCSERVER

where SCSERVER is the library in which the Warehouse Manager Server isinstalled.

» To stop Orion Application Server, at the i Series prompt, type ENDORI.
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Analyzer Installation Checklist

Before beginning install ation, make sure you have the following components and have completed
the following steps.

m  0S/400 V5R1 operating system

m STRATEGY 4.5 library installed into anew 4.50.040 Warehouse Manager Server library. We
do not recommend installing Analyzer 6.1 over an existing production library. Instead, install a
new 4.5 library and apply patch 4. When you install STRATEGY, be sureto install the Orion
Application Server and make note of the Orion port number.

Orion Application Server installed and stopped

Orion Application Server port number

Esshase/400 6.5 servers (OLAP and EES) installed and running

EES Server |P address (default 127.0.0.1)

EES Server port number (example 5001)

EES domain (type Essbase)

Java Developer Kit 1.3.1 with Java group PTF SF99069-11 or later

Database group PTF SF99501-09 or later and ability to run the RUNSQLSTM command.
Internet Explorer 5.5 or higher with Sun Java Plug-in 1.3.1

Analyzer 6.1 is not currently installed in the library where you plan to install.

Installing Analyzer

>

>

Insert the CD into the iSeries CD drive.

Log on with QSECOFR or equivalent authority (* ALLOBJ, *IOSYSCFG, * SAVSYS, *JOBCTL,
and * SECADM specia authorities are needed). Theinstallation will fail if theinstalling profile's
User Profile setting is OWNER(* GRPPRF). * GRPPRF cannot own new objects created by
theinstalling profile.

Type LODRUN and press F4.
Y ou are prompted for a device name. Choose * OPT or the name of your optical device.
Y ou are prompted for a path name. Accept the default path.

On the next screen, you are prompted for the following information. If you will not use Analyzer
with multidimensional databases, you can accept the default information.

4.5 Warehouse Manager Server library name (default is SCSERVER).
Essbase Enterprise Server (EES) I P address (default 127.0.0.1).

EES server port (default 5001).

EES domain (use Essbase.)
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Installation and Uninstallation

» At the confirmation screen, enter Y to begin installation.

» When theinstallation is successful, you will see the message "Analyzer setup completed
successfully.”

To connect to the Analyzer Launch Page, see instructionsin “ Connecting to the Analyzer Launch
Page” on p. 21.

Uninstalling Analyzer
Warning: When you uninstall Analyzer 6.1, all of your Analyzer 6.1 information, including any
data and reports created with Analyzer 6.1, will be removed. However, uninstalling Analyzer will

not affect data created in Enterprise Reporting.

» Stop the Orion Application Server, using the instructionsin To Start and Stop Orion Application
Server on an iSeries.

» Using a QSECOFR profile with * ALLOBJ authority, run the following command, where
SCSERVER isthe library in which the Warehouse Manager Server isinstalled:

RSTOBJ OBJ(*ALL) SAVLIB(QTEMP) DEV(*SAVF) SAVF(SCSERVER/UNINSTANZ)
» Type QTEMP/UNINSTANZ, and press F4 to prompt.
» Enter the name of your 4.5 Warehouse Manager Server library where Analyzer isinstalled.
» At the confirmation screen, enter Y to begin uninstalling.

» When the uninstallation is successful, you will see the message "Analyzer uninstall completed
successfully.”
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Analyzer Administration

This chapter describes how to connect to the Analyzer Launch page, how to set up and manage
security, and how to connect Analyzer to Essbase/400.

Connecting to the Analyzer Launch Page

» Start the Orion Application Server, using the instructionsin “To Start or Stop Orion Application
Server on an iSeries’ on p. 17.

» Start Internet Explorer, and enter the following URL, where SERVERNAME is the name of your
iSeries, and ORIONPORT is your Orion server port number:

http://SERVERNAME:ORIONPORT/Analyzer6/index.html
For example: http://prodserver:48693/Analyzer6/index.html

» Click the Java Web Client link or the Analyzer Administration Tools link to log in.

If thisisthe first time you log in, you may be prompted to install the Java Runtime Environment.
» You will be prompted with a Java Security Warning. Select Grant this Session to continue.
» At the Login dialog box, enter your user ID and password. Analyzer has an initial user 1D,

Administrator, and password, password. They are case sensitive. Usethisinformationto log in the
first time. Y ou may then want to change the password for security reasons.

Responding to the Java Security Warning

To avoid unexpected problems with the Analyzer applet, when you log in to Java Web Client or
Anayzer Administrator Tools, we recommend choosing the Grant this session button or the Grant
always button on the Java Security Warning.

Security Settings

Inthisversion of Analyzer, there are two avail able security settings, OS/400 and Analyzer security
and Analyzer Security Only. You can access them via the Analyzer Administration Tools link.
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0S/400 and Analyzer Security. This Analyzer Integrated Security setting is the default setting and
recommended security setting. If you usethis setting with Essbase/400 | ntegrated Security, user IDs
and passwords will be authenticated based on OS/400 security. You do not need to recreate usersin
Analyzer that you previously created on the OS/400. You will only need to createidentically-named
user groups on the OS/400 and in Analyzer and assign Analyzer report groups, databases, and roles
to these groups. See “Managing User Groups® on p. 24.

If you use this setting without Essbase/400 Integrated Security, you must complete some
additional steps using Essbase/400 Enterprise Services (EES). See “When to Use Essbase/400
Enterprise Services (EES)” on p. 27.

Analyzer Security Only. With this setting, you create user |Ds and passwords in Analyzer security.
These user IDs and passwords will not be linked to the i Series, Essbase/400, or Essbase/400
Enterprise Services (EES), so to access any of the servers, you must maintain user IDs and
passwords in each location.

If you use this setting and want to access Essbase/400 via Analyzer, you must maintain users and
passwordsin Analyzer and in Essbase/400. Because Analyzer uses EES to connect to Essbase/400,
you must then use an i Series command line to add the Essbase/400 servers and users and passwords
to EES so Analyzer users can connect to Essbase/400.

The Esshase and Analyzer Security option is not available in this version.

Setting Up Security

>

Set up security in the following order:

Determine and specify a security setting. For instructions, see “Choosing a Security Setting” on p.
23.

Thefollowing instructionsapply if you are using the default security setting, 0S/400 and Analyzer
security.

Add Essbase/400 OLAP server(s) to EES so Analyzer can access the Essbase/400 databases. For
instructions, see“ Connecting Analyzer to Essbase/400” on p. 27.

Use Warehouse Manager Client or an iSeries command line to create an Analyzer-specific user
group on the 0S/400, and add usersto it.

Analyzer is pre-set with an Activation User Group called OS400USERS. This group isthe
default group for al integrated users, and it governs whether or not a user on the external system
canloginto Analyzer. To allow OS/400 usersto log in to Analyzer, you must create an identically
named user group (OSA00USERS) on the OS/400 and add Analyzer usersto it.

In Analyzer, assign authority or properties to the Activation User Group (OS400U SERS) that will
apply to al externally authenticated users.
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Choosing a Security Setting

» Open the Analyzer Launch Page. For instructions, see “Connecting to the Analyzer Launch Page”
onp. 21.

» Click the Analyzer Administration Tools link.

» When prompted, log in. If thisisyour first timelogging in, use the default user 1D, Administrator,
and default password, password. These are case sensitive.

» On the Edit menu, choose System Settings.

» Thedefault setting, Use OS/400 and Analyzer security, is selected. The default Activation User
Group, OHAOOUSERS is also set. If thisis acceptable, click OK.

Figure 4-1
System Setting dialog box

Spsztem Settings m

(AuthemicatinnISecurity |

Integrated Security

) Use Analyzer security only

Activation Ulser Group
) Lse 05400 and Analyzer security DS400USERS ¥

Analyzer Security Password Expiration

[ Periodically Expire Passwords

| 014 || Cancel |

-

You must specify one of two available security settings:

Analyzer security only. User |Ds and passwords will be authenticated based on Analyzer security
you implement. To create and manage Analyzer users, user groups, and report groups, see the
Analyzer Administration Tools online help.

Note: Analyzer-only user IDs and passwords are case sensitive.
Essbhase and Analyzer security. Not availablein this version.

0S/400 and Analyzer security. Thisis the default and recommended setting. Members of the
Activation User Group on the OS/400 will be authenticated based on OS/400 security. The default
Activation User Group is OSA00USERS. To allow OS/400 usersto log in to Analyzer, you must
create an identically named user group on the OS/400 and add Analyzer userstoit. See“Managing
User Groups’ on p. 24.
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Managing User Groups

There are three types of user groupsin Analyzer:

Activation User Group. The Activation User Group is the default group for all integrated users and
governs whether or not an OS/400 user can log in to Analyzer. The default is OSA00USERS, and
this user group has the Integrated Security enabled check box selected by default. To alow
0S/400 usersto log in to Analyzer, you must create an identically named user group
(OHAOOUSERS) on the OS/400 and add Analyzer usersto it (using Warehouse Manager Client or
an OS/400 command line). If auser is not amember of the external OS/400 group, that user will
not be able to log in to Analyzer.

Note: You can change the name of the Activation User Group. See “ Changing the Activation
Group” on p. 25.

Integrated User Groups. With OS/400 and Analyzer security, use Analyzer to create identically-
named user groups as your OS/400 user groups, and assign Analyzer report groups, databases, and
roles to these user groups. For instructions on creating a new user group, see the Analyzer
Administration Tools online help.

When creating identically-named user groups (for example, Marketing), on the General tab of the
group, select the Integrated security enabled check box. Analyzer user group membership isthen
managed by the OS/400.

Important: When Analyzer Integrated Security is enabled, you must use the OS/400 to add and
remove OS/400 users from user groups. (Use Warehouse Manager Client or an iSeries command
line.) Do not use Analyzer to add OS/400 users to Analyzer Integrated Security user groups or
remove OS/400 users from Analyzer Integrated Security user groups. Analyzer is re-synchronized
with the OS/400 each time a user logsin to Analyzer, so changes made in Analyzer will not take
effect.

If you wish, you can add Analyzer-only usersto integrated user groupsin Analyzer. These usersare
not governed by external servers.

Analyzer-Only User Groups. |f you want to create user groups that are not managed from the OS/400
(Analyzer only), create user groupsin Analyzer and do not select the Integrated security enabled
check box.



25

Analyzer Administration

Figure 4-2
Creating a new user group

Analyzer Administration Tools !EI n
File Edit Help

I Databases [ General | Users | ReportGroups | Databases | Roles |

3 Report Groups

[ Roles

= [ User Groups [marksting |
¥ actgroupt Description

ﬁ Administrators - -
“ OS400USERS |Ident|ca|t0 Q5400 Marketing Group |

I users

Name

[v] Integrated security enabled

Apply

Changing the Activation Group

If you are using Essbase/400 Integrated Security and you aready have a group profile that
identifies OS/400 users with accessto Essbase/400 (default name is ESSUSERS), you may want to
use your existing group as your Analyzer Activation Group. To do this, create auser group in
Analyzer with the same name as your Essbase/400 group.

To change your Activation Group:
» Open Anayzer Administration Tools.

» Create an new user group in Analyzer with the same name as the OS/400 group that will allow
users to access Analyzer. Y ou may want to use ESSUSERS

» On the General tab of the group, select the Integrated security enabled check box.
» On the Edit menu, select System Settings.
» Select 0S/400 and Analyzer security, and in the Activation User Group drop-down, select your

new group (ESSUSERS). This new group becomes the default user group for all integrated users
and governs whether or not an OS/400 user can log in to Analyzer.
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Guidelines for Using Analyzer Integrated Security

When using Analyzer Integrated Security (OS/400 with Analyzer security), users and passwords
are authenticated based on the OS/400. The following situations apply to systems with Analyzer
Integrated Security enabled.

Administrative User

Theinitial Administrative user, Administrator, is exempt from Analyzer Integrated Security
(Analyzer with OS/400 security).

Adding Users or Groups

Y ou must use the OS/400 to add OS/400 usersto user groups. (Use Warehouse Manager Client
or an iSeries command line.) Do not use Analyzer to add OS/400 usersto Analyzer Integrated
Security user groups. Analyzer is re-synchronized with the OS/400 each time a user logsin to
Analyzer, so changes made in Analyzer will not take effect.

When you create a new OS/400 user and assign it membership to the Activation User Group
(OSA00USERS), the user is automatically added to Analyzer upon login.

When auser logsin to Analyzer, the user is added to Analyzer. If thereis a group associated
with the user on the OS/400, and that group is also an Analyzer user group and managed by
Analyzer Integrated Security (specified in the Integrated security enabled check box on the
General tab of the user group), then the user will be added to that Analyzer group and inherit its
properties.

Removing Users or User Groups

Y ou cannot remove a user group that has the Integrated Security enabled check box selected.
Y ou must use the OS/400 to remove OS/400 users from user groups. Do not use Analyzer.

If you remove a user from the Activation User Group on the OS/400, the user will no longer
have access to Analyzer. However, all objects that the user owns or has created remain on the
server.

If auserisavalid OS/400 user AND avalid Analyzer user AND a member of the Analyzer
Activation User Group BUT not a member of the OS/400 group that identically matches the
Analyzer Activation User Group, this user will be removed from Analyzer upon login.

Y ou cannot desel ect the Integrated Security enabled check box for the Activation User Group.

Security Hints and Restrictions

Thereisno lockout recovery. Administrators|ocked out of Analyzer must reinstall the product.
Do not lose or forget your Administrator password. If you are locked out of Analyzer and must
reinstall, al datawill be lost. There is no way to rebuild or recover your repository.
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Hints for Analyzer Integrated Users

m  When you are using the default security setting, Analyzer with OS/400 security, follow the
password guidelines for your OS/400.

m You canonly sign onto Analyzer with a password of 30 characters maximum.

m  When Administrators create OS/400 user profiles and set the password to expired, the user will
not be prompted to change their password when logging in to Analyzer if this user has never
logged in to Analyzer before. Externally authenticated users must log in at least once before
they can take advantage of the change expired password tool.

Hints for Analyzer Only Users

m  The Analyzer user ID and password are case sensitive.
m  Analyzer passwords must be between 6 and 30 characters.
m  Analyzer passwords must be alphanumeric.

Connecting Analyzer to Esshase/400

Analyzer connects to the Essbase/400 OLAP Server via Essbase/400 Enterprise Services (EES).

EES acts like a gate between Essbase/400 and Analyzer, so to access to Essbase/400 servers and
user profiles with Analyzer, you must add them to EES. The Essbase/400 information you add to
EES depends on your security setting.

Note: Thisversion of EES supports the TCP/I P communications protocol only.

When to Use Esshase/400 Enterprise Services (EES)

m  All Essbase/400 OLAP serversthat Analyzer needs to access must be added to EES.

m If youarenot using Essbase/400 Integrated Security, all Essbase/400 usersthat need to connect
to Analyzer must be maintained in EES.

Expired Esshase/400 Passwords

If you are not using Essbase/400 Integrated Security: Analyzer does not recognize expired
Essbase/400 passwords, and changing an Essbase/400 password does not automatically update
EES passwords. Therefore, if an Essbase/400 password changes or expires, an administrator must
log in to EES and change the EES password to match the new Essbase/400 password. Then
Analyzer will be able to connect the user to Essbase/400.

Signing on to EES

Administrative user. The EES administrative user isthe only user that should administer EES. The
user nameissystemand theinitial password is password. They are case sensitive. You may change
the password after the initial signon.
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>

Working

Administrative command. The command for configuring and administering the EES command
console is STREESCMD. With it, you can specify the Essbase/400 servers and users that Analyzer
needs to connect.

Tosignon to EES:

Before you sign on to EES, the EES server must be running. For instructions on starting the EES
server, see the Essbase/400 6.5 Administrator’s Guide, Chapter 2.

At an iSeries command line, type the following command, where ESSBASE isthe library where
you installed Essbase/400: ESSBASE/STREESCMD.

If thisisthefirst time the command is run, it may take a few minutes to compile the Java.

Y ou will see a screen with the ESS> prompt. On the command line, you can type Help for alist of
EES subcommands.

To sign on to the Essbase/400 domain, type signon. The signon prompts for the following
information, separated by commas:

m User. Enter the default administrative user, system.

Password. Enter the default administrative user’s password, password.

Domain. Enter Essbase.

Prefserver. Enter localhost or your iSeries name or | P address.

Plugin. Always enter TCPIP for plugin.

Port. Enter the EES port number that you chose during Essbase/400 installation.

Enter the information in the following format: user,password,domain,prefserver,plugin,port
For example, enter: system,password,Essbase,|ocalhost, TCPIP,45897

After you successfully sign on, you can perform other EES activities, including adding an OLAP
server and users.

with EES

When you sign on to EES, the following subcommands allow you to work with EES. Typing Help
at the ESS prompt will list the subcommands and a description of each.

Table 4-1
EES subcommands

Quit/exit Listusers Apiver

Help Removeuser Setprompt

Adduser Addolapserver Apiverdetail

Signon Listolapservers Synccubereplicas (not supported in this version)
Signoff Removeol apserver Runningeesservers (not supported in this version)

Syncsectoees Changepwd
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Figure 4-3
EES commands on the iSeries display
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ESS>
> help
quitsexit - exit the command console
help - help for commands
runningeesservers - lists all the currently running ees servers
signon - sign on to domain
signoff - sign off from domain
apiver - api wversiaon
apiverdetail - api wersion detail
adduser - adds an user to the root domain
changepwd - changes the password for a user
listusers - lists the users in the root domain
removeUser - remowes an user in the root domain
===5

Ml

Use addolapserver to add an Essbase/400 OLAP server to EES so Analyzer can connect to
Essbase/400. Use adduser to add Essbase/400 users to EES so the users can connect to
Essbase/400 via Analyzer. Note that you cannot add Essbase/400 groupsto EES.

To run an EES subcommand:
Type the subcommand and press Enter.

Y ou will be prompted to enter information to complete the task. For example, if you want to add a
user to EES, type adduser, and press Enter.

The display prompts for the following information:

Enter input as userName,password.

Enter the Essbase/400 user name and password, and press Enter to add the user to EES. When this

user logsin to Analyzer, he/she will have accessto the Essbase/400 OL AP server you specify with
the addolapserver command

Changing the EES Port Number

Analyzer uses the Analyzer.properties file to connect to the EES server. The EES information in
the Analyzer.properties file should always match the information in the Essbase.properties file.
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When you change your EES port number in the Essbase.properties file, you must also change the
Analyzer.propertiesfile.

Changing the Esshase.properties File

EESis configured using the Essbase.properties file. The only changes you should maketo thisfile
are changes to the EES TCP/IP port number.

To change the EES server port number:

Run the following command, where ESSBASE is the name of your Essbase/400 installation library:
EDTF /ESSBASE/JAVA/ESSBASE.PROPERTIES’

Find the following line: Server. TCPIP.Port=xxxxx
Replace the number with your new number, and save thefile.

To remove the service table entry containing the old port number, type the following command:
RMVSRVTBLE SERVICE(ESSBASE_ENTERPRISE) PORT (xxxxx) PROTOCOL(TCP)

where xxxxx is your old port number.

To add the new service table entry, type the following command:
ADDSRVTBLE SERVICE(ESSBASE_ENTERPRISE) PORT (xxxxx) PROTOCOL(TCP)
where xxxxx IS your new port number.

Stop and restart your EES server. For instructions, see the Essbase/400 6.5 Administrator’s Guide,
Chapter 2.

Changing the Analyzer.properties File

>

>

You should modify the Analyzer.properties file in the following instances:

m If you change the EES port in the Essbase.propertiesfile, you should also change the EES port
in the Analyzer.propertiesfile.

m If you switch to use a different EES server, you should change the IP address and/or the port
number in the Analyzer.properties file.

To change the Analyzer.propertiesfile:

Run the following command, where SCSERVER is the name of your STRATEGY installation
library:

EDTF '/SCSERVER/PRODDATA/CONFIG/ANALYZER.PROPERTIES’

The only properties you should change are:
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SPSS.EES.|P=xx.xx.xx.xx (EES server |P address)
SPSS.EES.PORT=xxxxx (EES server |P port number)

Replace the number(s) with your new number(s), and save thefile.

» Before changes will take effect, you must stop and restart the Orion Application Server. For
instructions, see “ Starting and Stopping Orion Application Server” on p. 17.

Troubleshooting Analyzer

Object xxx.x.x.x not found.
If you receivethiserrorin Analyzer, your Essbase/400 OL AP Server has not been added to EES.
Use the EES subcommand addolapserver to add your Essbase/400 OLAP server to EES.

Unable to Log In to Analyzer
If you or your users cannot log in to Analyzer, check your Essbase/400 OLAP Server
application and database privileges and group membership, and check all user IDs and passwords.

Other Problems
If you have unexplained problems, the Essbase/400 server may havetimed out. If this happens,
log out of Analyzer and log back in. You can change the timeout value in Application Manager.

Modifying the Security Setting

If, after you have set your security setting, you modify the setting in the System Settings dialog
box, andif there are usersthat were externally authenticated (on the OS/400), you will be prompted
to convert the profiles or remove them from Analyzer security.

For example, if you had originally specified Analyzer and OS/400 security, but later modify the
setting to use Analyzer security only, aModifying the Authentication message will appear if there
are usersin the Activation User Group (OSA400USERS) that were externally authenticated. You
must specify whether those userswill be granted accessto Analyzer (Convert) or denied accessto
Analyzer (Delete). For more information, see the Modifying the Authentication help topicin
Analyzer Administration Tools online help.

Important: If you convert from integrated security to Analyzer-only security, user IDs and
passwords become case sensitive. Thisis because Analyzer passwords are case sensitive.
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